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II. KAJIAN PUSTAKA 

 

2.1  Multimedia Pembelajaran Berbasis Komputer 

 

2.1.1  Pengertian Multimedia 

 

Menurut Munir (2008:138), “media berasal dari kata Medium (bahasa latin) yang 

berarti perantara atau pengantar”. Sehingga media dapat diartikan sebagai 

pengantar atau perantara pesan yang akan disampaikan dari sumber pesan kepada 

penerima pesan. Media pembelajaran meliputi segala sesuatu yang dapat 

membantu pengajar dalam menyampaikan materi pembelajaran, sehingga dapat 

meningkatkan motivasi, daya pikir, dan pemahaman peserta didik terhadap materi 

pembelajaran yang sedang dibahas atau mempertahankan perhatian peserta 

terhadap materi yang sedang dibahas. 

 

Sedangkan Rusman (2011: 60) menyatakan bahwa “pembelajaran berbasis 

multimedia adalah kegiatan pembelajaran yang memanfaatkan komputer untuk 

membuat dan menggabungkan teks, grafik, audio, gambar bergerak (video dan 

animasi) dengan menggabungkan link dan tool yang memungkinkan pemakai 

untuk melakukan navigasi, berinteraksi, berkreasi, dan berkomunikasi”.  

 

Lebih lanjut Rusman (2011: 60) juga mengemukakan bahwa terdapat empat jenis 

media yang dapat digunakan dalam pembelajaran, yaitu media visual, audio, 

audio-visual, dan kelompok media penyaji. 
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Berdasarkan pendapat di atas dapat disimpulkan bahwa pembelajaran berbasis 

multimedia adalah kegiatan pembelajaran yang memanfaatkan komputer untuk 

membuat dan menggabungkan teks, grafik, audio, gambar bergerak (video dan 

animasi) untuk melakukan navigasi, berinteraksi, berkreasi, dan berkomunikasi, 

sehingga dapat meningkatkan motivasi, daya pikir, dan pemahaman peserta didik 

terhadap materi pembelajaran yang sedang dibahas atau mempertahankan 

perhatian peserta terhadap materi yang sedang dibahas. 

 

Selanjutnya Green & Brown (2002: 2-6) menyatakan bahwa “media interaktif 

berbasis komputer merupakan media tiga dimensi yang menyampaikan informasi 

tidak dalam bentuk penyajian, melainkan melalui ciri fisiknya sendiri”.  Media 

interaktif berbasis komputer adalah media yang menuntut siswa untuk berinteraksi 

selain melihat maupun mendengarkan, contohnya adalah program interaktif dalam 

pembelajaran berbasis komputer.  Multimedia interaktif menggabungkan dan 

mensinergikan semua media yang terdiri dari: a) teks, yaitu simbol berupa 

medium visual yang digunakan untuk menjelaskan bahasa lisan,  b) grafik, yaitu 

Seluruh gambar dua dimensi, c) audio, yaitu segala sesuatu yang bisa didengar 

dengan menggunakan indera pendengaran, dan d) interaktivitas, yaitu adalah 

rancangan dibalik suatu program multimedia. 

 

Selanjutnya Green & Brown (2002: 3) menjelaskan, terdapat beberapa metode 

yang digunakan dalam menyajikan multimedia, yaitu: 

a. Berbasis kertas (Paper-based), contoh: buku, majalah, brosur. 

b. Berbasis cahaya (Light-based), contoh: slide shows, transparasi. 

c. Berbasis suara (Audio-based), contoh: CD Players,  tape recorder, 

radio. 
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d. Berbasis gambar bergerak (Moving-image-based), contoh: televisi,  

VCR (Video cassette recorder), film. 

e. Berbasiskan digital (Digitally-based), contoh: komputer. 

 

Berdasarkan pendapat tersebut dapat disimpulkan bahwa multimedia interaktif 

adalah multimedia dengan menggabungkan dan mensinergikan semua media yang 

terdiri dari teks, grafik, audio, dan interaktivitas.  

 

2.1.2  Pemanfaatan Multimedia Berbasis Komputer dalam Pembelajaran 

 

 

2.1.2.1. Pembelajaran Berbasis Komputer (PBK)   

 

Rusman (2013:153) menyatakan bahwa “pembelajaran berbasis komputer 

merupakan program pembelajaran yang digunakan dalam proses pembelajaran 

dengan menggunakan software komputer (CD pembelajaran) berupa program 

komputer yang berisi tentang muatan pembelajaran yang meliputi: judul, tujuan, 

materi pembelajaran, dan evaluasi pembelajaran”.   

 

Program pembelajaran berbasis komputer diambil dari istilah: Computer Assisted 

Instructional (CAI), atau Computerf Based Education (CBE) atau Instructional 

Assisted Learning (IAL) atau Instructional Aplication Computer (IAC) atau 

Computer Based Instructional (CBI). 

 

2.1.2.2 Ciri Media Pembelajaran Berbasis Komputer 

 

Arsyad (2007:32) mengemukakan bahwa media berbasis komputer (baik 

perangkat keras maupun perangkat lunak) memiliki ciri-ciri sebagai berikut: 

1) Mereka dapat digunakan secara acak, non-sekuensial, atau secara linier. 

2) Mereka dapat digunakan berdasarkan keinginan siswa atau berdasarkan 

keinginan perancang/pengembang sebagaimana direncanakannya. 
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3) Biasanya gagasan-gagasan disajikan dalam gaya abstrak dengan kata, 

simbol dan grafik 

4) Prinsip-prinsip ilmu kognitif untuk mengembangkan media ini. 

5) Pembelajaran dapat berorientasi siswa dan melibatkan interaktivitas 

siswa yang tinggi. 

Berdasarkan uraian tersebut di atas, maka ciri-ciri utama media berbasis 

komputer tersebut sangat sesuai untuk digunakan dalam pembelajaran. Hal ini 

disebabkan materi/isi yang akan disajikan dapat disesuaikan dengan keinginan 

siswa atau guru sebagai perancang. Selain itu, dapat materi yang sifat abstrak 

dapat disajikan dalam bentuk grafik atau gambar, sehingga dapat mempermudah 

pemahaman siswa terhadap materi. 

 

2.1.2.3  Prinsip-prinsip Media Pembelajaran Berbasis Komputer 

 

Menurut Rusman (2013:155),  PBK mempunyai prinsip-prinsip sebagai berikut: 

1. Berorientasi pada tujuan pembelajaran 

Dalam mengembangkan PBK harus berorientasi pada tujuan 

pembelajaran baik kepada standar kompetensi, kompetensi dasar, 

dan indikator yang harus dicapai pada setiap kegiatan pembelajaran.    

2. Berorientasi pada pembelajaran individual 

Dalam pelaksanaannya PBK memberikan keleluasaan pada siswa 

untuk menggunakan waktu sesuai dengan kebutuhan dan 

kemampuannya.   

3. Berorientasi pada pembelajaran mandiri 

Dalam pelaksanaan PBK dilakukan secara mandiri, di mana guru 

hanya berperan sebagai fasilitator dan mediator, semua pengalaman 

belajar dikemas dalam program PBK dan siswa mengerjakannya 

secara mandiri.   

4. Berorientasi pada pembelajaran tuntas 

Dalam pelaksanaan PBK semua siswa harus dapat menyelesaikan 

semua pengalaman belajar yang dikemas dalam program PBK, baik 

itu berupa pemahaman materi dan tugas mengerjakan tes atau 

evaluasi yang harus diselesaikan dengan benar.   

 

Berdasarkan uraian di atas menunjukkan bahwa prinsip PBK sangat baik untuk 

meningkatkan hasil belajar siswa.  Hal ini terlihat bahwa PBK harus berorientasi 
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pada tujuan pembelajaran, mengutamakan aktivitas siswa, dan berorientasi pada 

ketuntasan belajar. 

 

2.1.2.4 Kelebihan Media Pembelajaran Berbasis Komputer 

 

Susilana (2008:125) mencantumkan beberapa kelebihan media berbasis 

komputer terkait dengan multimedia interaktif  yaitu: 

1) Memperjelas dan mempermudah penyajian pesan agar tidak terlalu 

bersifat verbalistis 

2) Mengatasi keterbatasan waktu, ruang dan daya indera siswa 

3) Dapat digunakan secara tepat dan bervariasi, antara lain untuk 

meningkatkan motivasi belajar siswa, memungkinkan siswa untuk 

belajar secara mandiri sesuai dengan kemampuan dan minatnya, dan 

meningkatkan siswa untuk dapat mengukur atau mengevaluasi 

sendiri hasil belajarnya. 

 

Berdasarkan uraian di atas, maka peneliti menyimpulkan bahwa umum 

kelebihan media berbasis computer adalah tidak bersifat verbilitas, efisiensi 

waktu, dan dapat menciptakan kemandirian siswa. 

 

Hal tersebut di atas didukungan oleh Miarso (2004: 458), bahwa keuntungan 

dari pembelajaran berbasis komputer adalah: 

1) Mampu memberikan rangasangan yang bervariasi kepada otak 

2) Mampu mengatasi keterbatasan pengalaman yang dimiliki siswa 

3) Mampu melampaui batas ruang  kelas 

4) Memungkinkan terjadinya interaksi secara langsung 

5) Mampu membangkitkan keinginan dan minat baru 

6) Mampu membangkitkan motivasi dan merangsang untuk belajar 

 

 

Sementara Arsyad (2007: 172), mengemukakan “beberapa kelebihan multimedia 

berbasis komputer menurut antara lain: merupakan dokumen hidup, dapat dilihat 

di layar monitor/diperbesar, dapat didengar suaranya, dan dapat dilihat 

gerakannya (video/animasi)”. 
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Berdasarkan pendapat-pendapat di atas dapat disimpulkan bahwa kelebihan-

kelebihan dalam pembelajaran berbasis komputer diharapkan dapat menjadikan 

proses pembelajaran menjadi lebih efektif dan hasil belajar serta motivasi belajar 

siswa bisa meningkat. 

 

2.1.2.5 Keterbatasan Media Pembelajaran Berbasis Komputer 

 

Susilana (2008: 125), selain beberapa kelebihan yang dimiliki, pembelajaran 

berbasis komputer juga memiliki keterbatasan-keterbatasan, yaitu: 

1) Terbatasnya waktu bagi siswa untuk berkonsultasi dengan guru 

mengenai materi pelajaran dalam kegiatan pembelajaran di kelas. 

2) Jumlah siswa yang terlalu banyak menyebabkan kurang tersedianya 

komentar atau jawaban yang cukup jelas dari guru, atas pertanyaan 

yang diajukan oleh siswa secara individual. 

3) Jumlah siswa yang terlalu banyak juga memiliki kecenderungan 

terjadinya penjiplakan oleh siswa pada saat mereka dihadapkan pada 

suatu masalah yang menuntut mereka menyelesaikan secara 

individual. 

 

 

Berdasarkan pendapat-pendapat di atas dapat disimpulkan bahwa keterbatasan 

dalam pembelajaran berbasis komputer ini tentunya dapat diminimalisir dengan 

merancang multimedia semenarik mungkin sehingga siswa termotivasi untuk 

belajar, guru meningkatkan kompetensinya dalam mengintegrasikan TIK dalam 

pembelajaran, serta perlu kerja sama yang baik antara guru sebagai perancang 

pembelajaran dengan programmer yang menguasai berbagai software 

pengembangan media dalam memproduksi (membuat) multimedia. 

  

2.1.2.6 Evaluasi Media Pembelajaran Berbasis Komputer 

 

Menurut Arsyad (2007: 175), “evaluasi media pembelajaran dapat dilakukan 

dengan berbagai cara, seperti diskusi kelas dan kelompok interviu perorangan, 
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observasi mengenai perilaku siswa, dan evaluasi media yang telah tersedia”. 

Sementara itu Sugiyono (2008: 302), mengemukakan bahwa “validasi produk 

dapat dilakukan dengan cara menghadirkan beberapa pakar atau tenaga ahli yang 

sudah berpengalaman untuk menilai produk baru yang dirancang tersebut”. 

 

Lebih lanjut Arsyad (2007: 174) mengemukakan bahwa evaluasi media 

pembelajaran mempunyai tujuan, yaitu: 

1) Menentukan apakah media pembelajaran itu efektif. 

2) Menentukan apakah media itu dapat diperbaiki atau ditingkatkan. 

3) Menentukan apakah media itu cost-effective dilihat dari hasil belajar 

siswa. 

4) Memilih media pembelajaran yang sesuai untuk dipergunakan dalam 

proses belajar mengajar di kelas. 

5) Menentukan apakah isi pelajaran sudah tepat disajikan dengan media 

itu.  

6) Menilai kemampuan guru menggunakan media pembelajaran. 

7) Mengetahui apakah media pembelajaran itu benar-benar memberi 

sumbangan terhadap hasii belajar seperti yang dinyatakan. 

8)   Mengetahui sikap siswa terhadap media pembelajaran. 

 

Lebih lanjut Walker dan Hess yang dikutip Arsyad (2007: 175) memberikan 

kriteria dalam mereviu perangkat lunak media pembelajaran yang berdasarkan 

kepada kualitas yaitu: 

1) Kualitas isi dan tujuan; ketepatan, kepentingan, kelengkapan, 

keseimbangan, minat/ perhatian, kesesuaian dengan situasi siswa,  

2)   Kualitas Instruksional; memberikan kesempatan belajar, memberikan 

bantuan belajar, kualitas memotivasi, fleksibilitas instruksionalnya, 

hubungan dengan program dan pembelajaran lainnya, kualitas sosial 

interaksi instruksionalnya, kualitas tes dan penilaiannya dan dapat 

membawa dampak bagi guru dan pembelajarannya,  

3) Kualitas teknis; keterbacaan, mudah digunakan, kualitas tampilan 

tayangan, kualitas penanganan jawaban, kualitas pengelolaan 

program dan kualitas pendokumentasiannya. 

 

Berdasarkan pendapat di atas dapat disimpulkan bahwa proses meriviu untuk 

menghasilkan perangkat lunak media pembelajaran yang memiliki kualitas isi 
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dan tujuan dapat dilakukan dengan analisis kebutuhan siswa.  Selanjutnya untuk 

kualitas instruksional dapat dilakukan dengan melibatkan pakar desain 

pembelajaran. Sedangkan untuk kualitas teknis, dapat melibatkan pakar media.  

 

2.2. Karakteristik Mata Pelajaran Dasar Kompetensi Keahlian Multimedia 

(Produktif Multimedia)  

  

Struktur kurikulum komptensi keahlian multimedia salah satunya ada pelajaran 

produktif multimedia.  Salah satu standar kompetensinya adalah menggabungkan 

audio visual kedalam sajian multimedia.  Multimedia adalah penggunaan dan 

pemrosesan beberapa media (text, audio, graphics, animation, video, and 

interactivity) yang berbeda untuk menyampaikan informasi atau menghasilkan 

produk multimedia (musik, video, film, game, entertaiment, dan lain-lain). 

Pada penelitian ini software yang digunakan adalah adobe audition.  Adobe 

Audition adalah software aplikasi penyunting suara standard yang profesional 

untuk memproduksi suara yang baik. Apakah untuk menciptakan berbagai format 

file suara, mengedit dan mencampur suara, menganalisa suara, merekam suara 

pada CD. 

      

A. Bekerja Dengan Sample Type 

 

Dalam bekerja dengan adobe audition, sebelum melakukan proses editing anda 

harus mengetahui dasar dari sample type. Sample type merupakan karakteristik 

dari sebuah file audio digital. Sample type terdiri atas Sample Rate, Bith Dape, 

dan Channel Format. Dengan memahami karakteristik dari tiap file audio digital, 
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anda akan lebih mudah dalam menentukan hasil output yang benar-benar sesuai 

dengan kebutuhan (Prabantini, 2009: 42). 

1) Sample Rate 

Sample rates merupakan angka yang menunjukkan nilai sinyal audio dalam 

hitungan detik. Satuan sample rate adalah Hz. Nilai sample rate menunjukkan 

kualitas audio yang dihasilkan saat dimainkan. Semakin tinggi nilai sample rate, 

kualitas suara semakin bagus. 

Berikut beberapa nilai sample rate yang umum digunakan dalam audio digital : 

1. 11.025 Hz, memiliki range frekuensi 0 - 5,512 Hz, kualitas suaranya setara 

radio AM (low-end multimedia) 

2. 22.050 Hz, memiliki range frekuensi 0 – 11,025 Hz, kualitas suara setara radio 

FM (high-end multimedia) 

3. 32.000 Hz, memiliki range frekuensi 0 – 16,000 Hz, kualitas suara lebih baik 

dari radio FM (standard broadcast rate) 

4. 44.100 Hz, memiliki range frekuensi 0 – 22,050 Hz, kualitas setara CD audio 

5. 48.000 Hz, memiliki range frekuensi 0 – 24,000 Hz, kualitasnya setara dengan 

standar DVD 

6. 96.000 Hz, memiliki range frekuensi 0 – 48.000 Hz, kualitas audionya terbaik 

dan setara dengan high-end DVD 

 

 

 

 

Gambar 2.1 Tampilan Sample Rate 
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(Prabantini, 2009: 42-43) 

2) Bith Dept 

Pada audio digital, bith dept diartikan sebagai resolusi atau kedalaman suara yang 

menandakan jangkauan level suatu volume. Sebagai contoh audio dengan 8-bit 

hanya menyediakan 256 volume suara sedangkan pada resolusi 16-bit volume 

yang dihasilkan hingga 65.536. Adobe Audition mendukung pengaturan bit dept 

hingga 32 bit. Semakin tinggi bith dept maka ukuran file yang dihasilkan semakin 

besar. 

 

 

 

 

 

 

Gambar 2.2 Tampilan Bit Depth 

 

 

 

 

 

 

 

Gambar 2.3 Tampilan Kualitas Bit Depth 

(Prabantini, 2009: 43-44) 
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3) Channel Format 

Channel format terdiri atas dua jenis yaitu mono dan stereo. Format mono 

menghasilkan sebuah karakter suara yang menyatu pada kanal kanan dan kiri, 

format stereo dapat menghasilkan dua karakter suara yang terpisah antara kanal 

kanan dan kiri. Jadi jika anda mainkan file audio dengan format mono, suara yang 

keluar dari speaker kanal kanan dan kiri adalah sama. Sedangkan pada format 

stereo, suara yang keluar dapat berbeda antara kanal kanan dan kiri dan saling 

melengkapi sehingga saling menghasilkan komposisi lagu yang dinamis. 

 

 

 

 

 

 

Gambar 2.4 Tampilan Sinyal Mono 

 

 

  

 

 

 

Gambar 2.5 Tampilan Sinyal Stereo 

(Prabantini, 2009: 44-45) 
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B. Mengolah Suara dengan Adobe Audition   

Adobe Audition adalah multitrack digital audio recording, editor dan mixer yang 

udah digunakan dan memiliki berbagai fasilitas pengolahan suara. Dengan Adobe 

udition Anda dapat merekam suara, memperbaiki kualitas suara, menambahkan 

berbagai efek suara, dan menggabungkan dengan berbagai track suara menjadi 

satu track, dan menyimpannya dalam berbagai format. Adobe Audition banyak 

digunakan oleh musician recording master, demo cd, produser atau programing 

stasiun radio. Secara umum Adobe Audition memiliki dua lingkungan yaitu Edit 

View and Multitrack.  

Edit View sesuai namanya ditujukan terutama untuk menangani editing satu 

waveform saja pada satu saat. Sementara Multitrack View dapat menangani 

beberapa waveform sekaligus pada beberapa track. Anda dapat menggunakan 

kedua lingkungan ini secara bergantian pada tampilan terpisah. Latihan berikut 

akan memandu Anda untuk mengenal Adobe Audition yang dimulai dari 

lingkungan Edit Waveform View. 

1)  Mengenal tampilan Edit View 

Anda dapat menggunakan Edit View untuk merekam, memainkan, mengubah, dan 

mengedit satu waveform. Juga, Anda dapat menambah efek suara hingga 

mengurangi noise. 
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Gambar 2.6 Tampilan Edit View 

(Prabantini, 2009: 13-14) 

 

2) Memainkan file suara  

Untuk memulai latihan bukalah dokumen dengan nama Saleen_Ambient_ 

Bed.wav menggunakan menu File > Open. Karena stereo maka pada Waveform 

Display akan terlihat bentuk waveform yang terdiri dari dua bagian. Bagian atas 

menunjukkan channel kiri dan bawah berarti channel kanan. 

 

 

 

 

 

 

Gambar 2.7 Waveform Display 
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Anda dapat mendengarkan suara seluruh waveform dengan menekan tombol Play, 

dan Playback cursor akan berjalan dari kiri ke kanan. 

(Prabantini, 2009: 33-36) 

 

3) Menggunakan Horisontal Zoom 

Zoom In berguna untuk memperbesar tampilan waveform dari tengah pointer. 

Klik tombol Zoom In beberapa kali, maka tampilan waveform akan menjadi lebih 

detil. 

 

 

 

 

 

 

Gambar 2.8  Tampilan waveform 

 

 

 

 

 

 

 

Gambar 2.9  Tampilan Horisontal Zoom 
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Setelah itu gunakan Time Ruler di bagian bawah layar atau Display Range Bar di 

bagian atas layar untuk menggeser tampilan waveform secara horisontal.  

Kebalikan dari Zoom In, Zoom Out berguna untuk mengembalikan tampilan 

waveform. Klik Zoom Out beberapa kali. Dan Zoom Full berguna untuk 

menampilkan seluruh waveform. 

 

Zoom to Selection berguna untuk memperbesar tampilan waveform pada bagian 

yang terseleksi saja. Anda dapat menyeleksi waveform dahulu, kemudian klik 

tombol Zoom to Selection. Zoom to Left of Selection/ Zoom to Right of Selection 

berguna untuk memperbesar tampilan bagian kiri/kanan waveform yang terseleksi.  

 

(Prabantini, 2009: 149-150) 

4) Menggunakan Vertical Zoom 

Zoom In berguna untuk memperbesar skala vertikal pada amplitude ruler.  Zoom 

Out berguna untuk memperkecil skala vertikal pada amplitude ruler. Kliktombol 

Zoom In beberapa kali, maka tampilan waveform akan membesar secara vertikal. 

Dan gunakan Amplitude Ruler untuk menggeser tampilannya secara vertikal. 

 

 

 

 

 

 

Gambar 2.10  Tampilan Vertical Zoom 

(Prabantini, 2009: 150-151) 
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5) Menyeleksi Waveform 

Berikutnya Anda dapat menyeleksi sebagian waveform dengan klik tombol kiri 

dan drag ke kanan atau kiri. Maka akan terlihat blok dengan warna lain. 

Tekan tombol Play lagi untuk memainkan sebagian waveform. Anda dapat pula 

menyeleksi sebagian waveform pada salah satu channel dengan cara sama.  

 

 

 

 

 

 

 

Gambar 2.11  Tampilan Menyeleksi Sebagian waveform 

 

Arahkan pointer ke bagian atas channel kiri untuk memilih channel kiri saja, atau 

bagian bawah channel kanan untuk memilih channel kanan saja.  Dan untuk dapat 

memilih semua channel lagi, klik pada bagian tengah antara channel kiri dan 

kanan. 

 

 

 

 

 

Gambar 2.12 Tampilan  Menyeleksi Sebagian waveform pada Bagian Chanel Kiri 
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Anda dapat pula menyeleksi seluruh waveform dengan double klik.   

 

 

 

 

 

 

Gambar 2.13 Tampilan Menyeleksi Seluruh Bagian waveform 

 

(Prabantini, 2009: 52-57) 

6) Melakukan editing dasar 

Setelah Anda dapat menyeleksi waveform, kini Anda dapat berlatih untuk 

melakukan editing dasar, yaitu Cut, Copy, Paste dan Mix. Copy berguna untuk 

memindahkan bagian waveform yang terseleksi ke dalam internal clipboard. Cut 

berguna untuk memotong bagian waveform yang diseleksi dan memindahkannya 

ke dalam internal clipboard. Paste berguna untuk menambahkan data dari internal 

clipboard pada insertion point atau menggantikan bagian waveform yang 

terseleksi. Mix Paste hampir sama dengan Paste, bedanya Mix Paste akan 

mencampur antara waveform yang terseleksi atau mulai insertion point dengan 

data internal clipboard. 
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a) Cut 

Anda dapat menyeleksi sebagian waveform, misalnya bagian akhir. 

 

 

 

 

 

 

Gambar 2.14 Tampilan Menyeleksi Bagian Akhir waveform 

 

Dan kemudian gunakan menu Edit > Cut. Maka bagian waveform yang terseleksi 

akan hilang, dan perhatikan panjang waveform setelah dipotong. Dan tekan 

tombol Play untuk mendengarkan hasilnya. 

 

 

 

 

 

 

Gambar 2.15  Tampilan waveform Setelah Dipotong dengan Cut 

 

b) Paste  

Berikutnya Anda dapat memindahkan data dari internal clipboard pada satu titik 

tertentu atau menggantikan bagian waveform yang terseleksi. Anda dapat 
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memindahkan pointer ke posisi ke 0:05.000. Kemudian gunakan menu Edit > 

Paste. 

 

 

  

 

 

 

Gambar 2.16  Tampilan Menambah waveform dengan Paste 

 

Perhatikan waveform bertambah panjang. Dan tekan tombol Play untuk 

mendengarkan hasilnya. Selain itu Anda dapat menyeleksi bagian waveform 

dahulu. 

 

 

 

 

 

Gambar 2.17  Tampilan Menyeleksi Bagian waveform  

 

Kemudian menggantikan bagian waveform yang terseleksi dengan data dari 

internal clipboard dengan menu Edit > Paste. Kemudian tekan tombol Play untuk 

mendengarkan hasilnya. 
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Gambar 2.18  Tampilan Menggantikan waveform yang Terseleksi 

 

c) Mix Paste  

Untuk mencoba Mix Paste Anda dapat membatalkan perintah terakhir dengan 

menu Edit > Undo. Kemudian gunakan menu Edit > Mix Paste. Maka akan 

muncul Mix Paste Dialog di mana Anda dapat mengatur setting pencampuran 

waveformnya. Kemudian akhiri dengan menekan tombol OK. Dan tekan tombol 

Play untuk mendengarkan hasilnya. 

 

  

 

 

 

Gambar 2.19  Tampilan Mix Paste Dialog 

 

(Prabantini, 2009: 52-57) 
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2.3 Landasan Teori Belajar dan Pembelajaran 

 

2.3.1 Teori Belajar  

 

Belajar pada hakekatnya adalah proses interaksi terhadap semua situasi yang ada 

di sekitar individu siswa (Rusman, 2013: 83). Sedangkan Cronbach dalam 

Rusman (2013: 86) berpendapat bahwa  

Learning is shown by change in behavior as result of experience. Artinya 

belajar sebagai suatu aktivitas yang ditunjukkan oleh perubahan perilaku 

sebagai hasil pengalaman.  Menurut Burton (dalam Rusman, 2013: 86) 

mengartikan belajar sebagai perubahan tingkah laku pada diri individu 

berkat adanya interaksi individu dengan individu dan individu dengan 

lingkungannya. 

 

 

Selanjutnya Witherington dalam Hanafiah (2009: 7) menyatakan bahwa  

Belajar merupakan perubahan dalam kepribadian yang dimanifestasikan 

sebagai pola-pola respon baru yang berbentuk kepribadian, keterampilan, 

sikap, kebiasan, pengetahuan, dan kecakapan. Sedangkan Gagne, Berliner, 

dan Hilgard dalam Hanafiah dan Suhana  (2009: 7) menyatakan bahwa 

belajar adalah suatu perubahan perilaku yang muncul karena pengalaman.  

 

 

Lebih lanjut Slameto (2003: 2) menyatakan bahwa belajar adalah suatu proses 

usaha yang dilakukan oleh seseorang untuk memperoleh suatu perubahan tingkah 

laku yang baru secara keseluruhan, sebagai hasil pengalamannya sendiri dalam 

interaksi dengan lingkungannya.  

 

Hal ini didukung oleh pendapat Arsyad (2010: 1) yang menyatakan bahwa belajar 

adalah suatu proses kompleks yang terjadi pada diri setiap orang sepanjang 

hidupnya.  Proses belajar terjadi karena adanya interaksi antara seseorang dengan 

lingkungannya.  Oleh karena itu, belajar dapat terjadi kapan saja dan di mana saja. 
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Salah satu tanda bahwa seseorang itu telah belajar adalah terjadinya perubahan 

tingkah laku pada diri orang tersebut yang mungkin disebabkan oleh perubahan 

pada tingkat pengetahuan, keterampilan atau sikapnya. 

 

Selanjutnya Gagne dalam Sagala (2000: 13) menyatakan bahwa  

Belajar merupakan kegiatan yang kompleks, hasil belajar berupa 

kemampuan.  Setelah belajar orang memiliki keterampilan, pengetahuan, 

sikap dan nilai.  Timbulnya kemampuan tersebut disebabkan oleh stimulasi 

yang berasal dari lingkungan  serta proses kognitif yang dilakukan oleh 

peserta didik.  Dengan demikian belajar adalah seperangkat proses kognitif 

yang mengubah stimulasi lingkungan, melalui pengolahan informasi 

menjadi kemampuan baru. 

 

 

Sedangkan menurut Anderson (2001: 35) menyatakan bahwa “belajar adalah 

suatu proses perubahan yang relatif menetap yang terjadi dalam tingkah laku 

sebagai hasil dari pengalaman”.   

 

Selanjutnya Sardiman (2011: 22) berpendapat “Belajar suatu proses interaksi 

antara diri manusia dengan lingkungannya, yang mungkin berwujud pribadi, 

fakta, konsep ataupun teori”. Dalam hal ini terkandung suatu maksud bahwa 

proses interaksi adalah: Proses internalisasi dari sesuatu ke dalam diri yang belajar 

dan dilakukan secara aktif, dengan segenap panca indera ikut berperan. 

  

Lebih lanjut Hamalik (2001: 27) mengemukakan “belajar adalah modifikasi atau 

memperteguh kelakuan melalui pengalaman”.  Sedangkan menurut Thorndike 

dalam Riyanto (2010: 7) “Belajar adalah proses interaksi antara stimulus (berupa 

pikiran, perasaan, atau gerakan) dan respons (berupa pikiran, perasaan, atau 

gerakan)”. 
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Berdasarkan beberapa pendapat di atas, maka dapat disimpulkan bahwa belajar 

adalah proses interaksi siswa dengan lingkungannya yang ditunjukkan adanya 

perubahan perilaku. 

 

Menurut surya dalam Rusman (2013: 87) ada delapan ciri-ciri dari perubahan 

perilaku, yaitu: 

a. Perubahan yang disadari dan disengaja (Intensional) 

Perubahan perilaku yang terjadi merupakan usaha sadar dan 

disengaja dari individu yang bersangkutan. 

b. Perubahan yang berkesinambungan (Kontinu) 

Bertambahnya pengetahuan atau keterampilan yang dimiliki pada 

dasarnya merupakan kelanjutan dari pengetahuan dan keterampilan 

yang telah diperoleh sebelumnya.  

c. Perubahan yang fungsional 

Setiap perubahan perilaku yang terjadi dapat dimanfaatkan untuk 

kepentingan hidup individu yang bersangkutan, baik untuk 

kepentingan masa sekarang maupun masa mendatang. 

d. Perubahan yang bersifat positif 

Perubahan perilaku yang terjadi bersifat normatif dan menunjukkan 

ke arah kemajuan.  

e. Perubahan yang bersifat aktif 

Untuk memperoleh perilaku baru, individu yang bersangkutan 

berupaya melakukan perubahan. 

f.  Perubahan yang bersifat pemanen 

Perubahan perilaku yang diperoleh dari proses belajar cenderung dan 

menjadi bagian yang melekat dalam dirinya. 

g.  Perubahan yang bertujuan dan terarah 

Individu melakukan kegiatan belajar pasti ada tujuan yang diinginkan 

baik tujuan jangka pendek, jangka menengah maupun jangka panjang. 

h. Perubahan perilaku secara keseluruhan 

Perubahan perilaku belajar bukan hanya sekedar memperoleh 

pengetahuan semata, tetapi termasuk memperoleh pula perubahan 

dalam  keterampilannya. 

 

 

Berdasarkan uraian di atas peneliti menyimpulkan bahwa perubahan perilaku 

dalam belajar harus mencapai pada perubahan yang menyeluruh, karena 

perubahan ini mencakup semua aspek, bukan hanya pengetahuan tetapi juga 

keterampilan. 
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2.3.2  Teori Pembelajaran 

 

Menurut Rusman (2013: 92), “pembelajaran adalah suatu sistem yang terdiri dari 

berbagai komponen yang saling berhubungan satu dengan yang lain. Komponen 

tersebut meliputi tujuan, materi, metode, dan evaluasi”. 

 

Sedangkan menurut Hamalik (2001: 94) mengartikan “pembelajaran sebagai suatu 

kombinasi yang tersusun meliputi unsur manusia, material, fasilitas, 

perlengkapan, dan prosedur yang saling mempengaruhi untuk mencapai tujuan 

pembelajaran”.  

 

Lebih lanjut Warsita dalam Rusman (2013: 93) menyatakan “pembelajaran 

adalah suatu usaha untuk membuat peserta didik belajar atau suatu kegiatan 

untuk membelajarkan peserta didik”.  

Sedangkan menurut UU No.20 Tahun 2003 tentang Sisdiknas Pasal 1 Ayat 20 

menyebutkan bahwa:  

Pembelajaran adalah proses interaksi peserta didik dan sumber belajar 

pada suatu lingkungan belajar. Oleh karenan itu, ada lima jenis interaksi 

yang dapat berlangsung dalam proses belajar dan pembelajaran: yaitu 1) 

interaksi antara pendidik dan peserta didik, 2) interaksi antar sesama 

peserta didik, 3) interaksi peserta didik dengan narasumber, 4) interaksi 

peserta didik bersama pendidik dengan sumber belajar yang sengaja 

dikembangkan, dan 5) interaksi peserta didik bersama pendidik dengan 

lingkungan sosial dan alam.  

 

 

Berdasarkan pendapat-pendapat di atas dapat disimpulkan bahwa pembelajaran 

merupakan suatu usaha untuk membuat peserta didik belajar atau suatu kegiatan 

untuk membelajarkan peserta didik.  
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2.3.3 Teori Belajar Praktik  

 

Dalam proses pembelajaran praktik bagi siswa SMK sebenarnya tidak berbeda 

dengan pembelajaran lain pada umumnya, namun terdapat keterampilan khusus 

yang menjadi fokus utama dalam pembelajaran praktik. Begitu pula dengan teori 

belajar nya, terdapat beberapa teori belajar yang mengemukakan tentang teori 

belajar praktik. 

 

Teori belajar utama yang menjadi pijakan dalam belajar praktik adalah teori 

Behaviouristik ( tingkah laku ) yang dipelopori oleh Thorndike dan Skinner. Teori 

ini mengemukakan bahwa belajar adalah proses interaksi antara stimulus dan 

respon (yang berupa pikiran, perasaan atau gerakan). Lebih jelasnya bahwa 

perubahan tingkah laku boleh berwujud sesuatu yang konkret (dapat diamati) 

maupun yang nonkonkret (tidak bisa diamati). 

 

Dalam hubungan dengan belajar praktik, siswa yang melakukan kegiatan praktik 

adalah bentuk respon dari stimulus berupa perintah yang diberikan oleh guru. 

Perubahan tingkah laku yang ditampakkan siswa akan dapat dilihat secara konkret 

atau dapat diamati. Inilah teori belajar tingkah laku yang dalam pandangan 

Thorndike mengarah pada hasil belajar langsung, atau tingkah laku yang 

ditampilkan.  

 

Permbelajaran praktik juga merupakan pembelajaran keterampilan, yang dalam 

hal ini Klausmeier dalam Uno (2008: 198) mengidentifikasi tiga tahap dalam 

belajar keterampilan adalah : 
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(1) Tahap kognitif, yang biasanya berlangsung relative singkat. Pada tahap 

ini siswa mengkaji dan memikirkan bagaimana melakukan 

keterampilan sesuai dengan petunjuk manual yang dipelajari.  

(2) Tahap Intermediate/ tahap pengorganisasian. Pada tahap ini operasi 

reseptor-efektor-umpan balik, menjadi semakin terorganisir. Semakin 

sedikit perhatian yang diberikan pada gerakan tertentu. 

 (3) Tahap penyempurnaan. Pada tahap ini gerakan spesifik semakin lancar 

dan tidak membutuhkan perhatian yang terlalu besar, karena 

keterampilan semakin otomatis untuk dilakukan. 

 

 

Berdasarkan penjelasan di atas dapat disimpulkan bahwa pada dasarnya dalam 

pembelajaran praktik siswa SMK melakukan tiga tahapan, yaitu tahap kognitif, 

tahap pengorganisasian, dan tahap penyempurnaan.  

 

2.3.4   Teori Belajar yang Melandasi Pembelajaran Berbasis Komputer 

 

2.3.4.1  Teori Belajar Behaviorisme 

 

Salah satu teori belajar yang melandasi pembelajaran berbasis komputer adalah 

teori belajar behaviorisme, menurut teori ini belajar merupakan akibat adanya 

interaksi antara stimulus dan respon. Respon yang terjadi dapat disebabkan oleh 

adanya stimulus yang dikondisikan (conditioned stimulus) atau yang tidak 

dikondisikan (unconditioned stimulus). Teori behaviorisme memandang bahwa 

belajar adalah perubahan perilaku yang dapat diamati dan dapat diukur, diprediksi 

dan dikontrol. tidak menjelaskan perubahan internal pada diri siswa. Proses 

belajar dapat terjadi dengan bantuan media (alat). Pendapat Thorndike dalam 

Herpratiwi (2009: 8) mengatakan bahwa 

Untuk memperoleh suatu perubahan tingkah laku harus mengikuti 

hukum-hukum: 1) hukum kesiapan (law of readiness) yaitu semakin 

siap suatu organisme memperoleh suatu perubahan tingkah laku, maka 

pelaksanaan tingkah laku tersebut akan menimbulkan kepuasan individu 

sehingga asosiasi cenderung diperkuat; (2) hukum latihan (law of 

exercise) yaitu semakin sering suatu tingkah laku diulang, dilatih, 
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digunakan maka asosiasi tersebut semakin kuat; dan (3) hukum akibat 

(law of effect) yaitu hubungan stimulus respon cenderung diperkuat bila 

akibatnya menyenangkan dan cenderung diperlemah jika tidak 

memuaskan. 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa perubahan tingkah laku 

dapat terjadi apabila adanya kesiapan, latihan, dan adanya stimulus. 

 

Beberapa prinsip belajar menurut Skinner dalam Herpratiwi (2009: 10), yaitu:  

1) belajar harus segera diberitahukan pada siswa dan diberi penguat, 2) 

proses ajar harus mengikuti irama dari yang belajar, 3) materi belajar 

digunakan sistem modul, 3) pembelajaran lebih mementingkan aktivitas 

mandiri, 4) Prinsip-prinsip ini sesuai dengan ``pembelajaran dengan 

Multimedia Interaktif yang programnya menfasilitasi perbedaan 

pebelajar, adanya respon benar-salah, adanya penskoran dan unsur 

belajar mandiri. 

 

 

Hasil uraian di atas dapat disimpulkan bahwa prinsip belajar adalah pemberian 

dan penguatan informasi, menyesuaikan kondisi siswa, menggunakan modul, 

belajar mandiri, sistem pembelajaran merespon perbedaan karakterisitik 

pebelajar. 

 

2.3.4.2 Teori Belajar Sibernetik 

 

Ada dua macam proses berpikir menurut Landa dalam Herpratiwi (2009 : 67), 

yaitu algoritmik dan heuristik.  

Proses berpikir algoritmik adalah proses berpikir linier, konvergen, lurus 

menuju ke satu target tertentu. Proses belajar ini akan berhasil dengan 

baik jika apa yang hendak dipelajari telah diketahui ciri-cirinya. 

Sedangkan proses berpikir heuristik adalah cara berpikir divergen 

(menyebar), menuju kebeberapa target sekaligus. Sedangkan menurut 

Pask dan Scott membedakan proses berpikir itu dalam dua cara berpikir 

yaitu cara berpikir Wholist (menyeluruh) dan cara berpikir serialist 

(bagian). 

 

 



40 

 

Lebih lanjut Herpratiwi (2009: 70) menyatakan bahwa : 

Aplikasi teori belajar Sibernetik dalam pembelajaran mencakup beberapa 

tahapan yaitu: 1) menentukan tujuan instruksional, 2) menentukan materi 

pelajaran, 3) mengkaji sistem informasi yang terkandung dalam materi 

tersebut, 4) menentukan pendekatan belajar sesuai dengan sistem 

informasi, 5) menyusun materi pelajaran dalam urutan yang sesuai 

dengan sistem informasi, 6) menyajikan materi dan membimbing siswa 

belajar  

 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa teori belajar Sibernetik 

menekankan pada pemrosesan dan pengolahan informasi. Asumsi teori ini 

adalah tidak satupun jenis cara belajar yang ideal untuk segala situasi, sebab 

cara belajar sangat ditentukan oleh sistem informasi. Hal ini sejalan dengan 

perkembangan teknologi dan informasi saat ini. Pengembangan multimedia atau 

media berbahan komputer yang menyajikan informasi secara integral (teks, 

gambar, audio, animasi dan video) merupakan upaya untuk mengoptimalkan 

pemrosesan informasi secara verbal (auditory) dan visual. 

 

2.3.4.3 Teori Belajar Konstruktivisme 

 

Teori belajar konstruktivisme didefinisikan sebagai pembelajaran yang bersifat 

generatif, yaitu tindakan mencipta sesuatu makna dari apa yang sudah dipelajari. 

Siswa menemukan sendiri dan mentrasformasikan informasi kompleks, 

mengecek informasi baru dan merevisinya apabila aturan-aturan itu tidak sesuai. 

Filsafat konstruktivisme menjadi landasan strategi pembelajaran yang dikenal 

dengan student-centered learning. Pembelajaran ini mengutamakan keaktifan 

siswa sedangkan guru berperan sebagai fasilitator dan memberi arahan 

(scaffolding). 
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Ada tiga penekanan dalam teori belajar konstruktivisme yaitu: 1) peran aktif 

siswa dalam mengkonstruksi pengetahuan secara bermakna, 2) pentingya 

membuat kaitan antara gagasan dalam pengkonstruksian secara bermakna, 3) 

mengaitkan antara gagasan dengan infarmasi baru yang diterima. 

 

Pembelajaran dengan Multimedia Interaktif memungkinkan siswa lebih aktif 

dalam menggali informasi, memecahkan masalah dan menarik kesimpulan dari 

yang mereka pelajari. Multimedia Interaktif dalam fungsinya sebagai 

pendampingan belajar menjadi pijakan bagi siswa untuk mengeksplorasi dan 

mengolaborasi informasi-informasi yang sedang dipelajari. 

 

2.4   Teori Algoritma Komputer  

 

Landa (1976: 10-11) menyatakan bahwa: 

Algoritma adalah salah satu jenis metode yang mendasar, dan bukan hanya 

untuk kegiatan intelektual. Dengan kata lain, gagasan algoritma bisa  

diterapkan tidak hanya untuk suatu kegiatan yang dilakukan melalui 

operasi intelektual, tetapi juga untuk kegiatan yang dilakukan melalui 

operasi fisik. Selain itu, algoritma dapat mengarahkan operasi untuk 

mesin. Algoritma juga digunakan untuk menguji metode umum yang 

mendasari aktivitas intelektual (atau penalaran umum). 

 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa alogaritma merupakan 

proses menciptakan gagasan berdasarkan proses penalaran secara ilmiah. 

 

Selanjutnya Haryanto (2007: 22) menyatakan bahwa: 

Dalam matematika dan komputasi, algoritma merupakan kumpulan 

perintah untuk menyelesaikan suatu masalah. Kumpulan perintah ini 

biasanya diterjemahkan oleh komputer secara bertahap dari yang pertama 

sampai yang terakhir secara sekuensial.  Masalah yang terkait disini dapat 

berupa berbagai macam masalah asalkan masalah tersebut memiliki 

kriteria kondisi awal yang harus dipenuhi sebelum menjalankan algoritma. 
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Berdasarkan pendapat di atas dapat disimpulkan bahwa algoritma adalah suatu 

metode untuk menyelesaikan suatu masalah yang bisa diterapkan tidak  hanya 

untuk suatu kegiatan yang dilakukan melalui operasi intelektual tetapi juga untuk 

kegiatan yang dilakukan melalui operasi fisik. 

 

Menurut Haryanto (2007: 22), jenis-jenis algoritma dapat diklasifikasikan 

berdasarkan metode yang digunakan untuk mendesain algoritma tersebut.  

Terdapat empat metode umum yang digunakan dalam mendesain algoritma yaitu: 

1. Devide and Conquer 

Devide and Conquer merupakan pendekatan algoritma yang membagi-

bagi permasalahan ke dalam bentuk yang lebih kecil, sehingga dapat 

dipecahkan secara terpisah.  Pendekatan ini memecahkan masalah ke 

dalam sub masalah yang mirip namun dengan ukuran yang lebih kecil, 

untuk kemudian dapat dipecahkan secara rekursif (perulangan).  Hasil 

pemecahan tiap-tiap sub masalah kemudian digabungkan kembali untuk 

mendapatkan solusi masalah secara keseluruhan. 

 

2. Dynamic Programming 

Dynamic Programming merupakan metode algoritma yang biasanya 

diaplikasikan pada masalah optimasi.  Masalah seperti ini dapat memiliki 

banyak solusi.  Setiap solusi memiliki nilai-nilai yang berbeda.  Disinilah 

tugas Dynamic Programming untuk mencari solusi yang paling optimal.   

Keuntungan Dynamic Programming adalah bahwa metode ini dapat 

mempersingkat waktu yang sangat signifikan bagi masalah yang memiliki 

lebih dari satu solusi, karena dapat menemukan solusi yang optimal.   
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3. Greedy Algorithms 

Merupakan metode yang akan selalu memilih pilihan yang terbaik di 

setiap langkahnya.  Greedy Algorithms selalu memilih pilihan optimal 

pada setiap langkahnya yang berpeluang tinggi untuk menjadi pilihan 

terbaik seterusnya. 

 

4. Amortized Analysis 

Dalam Amortized Analysis, waktu yang diperlukan untuk memproses 

struktur data terurut dirata-ratakan dari semua operasi.  Amortized Analysis 

dapat digunakan untuk menunjukkan bahwa nilai operasi rata-rata cukup 

kecil, walaupun ada beberapa operasi yang memiliki nilai besar.  Metode 

ini cukup berguna untuk menghitung nilai sumberdaya yang terbuang 

secara keseluruhan. 

 

2.5  Pendekatan Ilmiah Dalam Pembelajaran 

 

2.5.1 Esensi Pendekatan Ilmiah 

 

Pendekatan ilmiah diyakini sebagai titian emas perkembangan dan pengembangan 

sikap, keterampilan, dan pengetahuan peserta didik. Dalam pendekatan atau 

proses kerja yang memenuhi kriteria ilmiah, para ilmuwan lebih mengedepankan 

penalaran induktif (inductive reasoning) ketimbang penalaran deduktif (deductive 

reasoning).  Penalaran deduktif melihat fenomena umum untuk kemudian 

menarik simpulan yang spesifik. Sebaliknya, penalaran induktif memandang 

fenomena atau situasi spesifik untuk kemudian menarik simpulan secara 

keseluruhan. Sejatinya, penalaran induktif menempatkan bukti-bukti spesifik ke 
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dalam relasi idea yang lebih luas. Metode ilmiah umumnya menempatkan 

fenomena unik dengan kajian spesifik dan detail untuk kemudian merumuskan 

simpulan umum (Kemendikbud, 2013: 1). 

 

Berdasarkan pengertian tersebut menunjukkan bahwa pendekatan ilmiah adalah 

proses ilmiah dalam rangka meningkatkan penalaran siswa dalam mengambil 

kesimpulan. Tujuannya untuk pengembangan sikap, pengetahuan, dan 

keterampilan siswa. 

 

2.5.2 Langkah-langkah Pembelajaran dengan Pendekatan Ilmiah 

 

Langkah-langkah pembelajaran dengan pendekatan ilmiah melalui tiga ranah, 

yaitu sikap, pengetahuan, dan keterampilan.  Dalam proses pembelajaran berbasis 

pendekatan ilmiah, ranah sikap menggamit transformasi substansi atau materi ajar 

agar peserta didik “tahu mengapa.” Ranah keterampilan  menggamit transformasi 

substansi atau materi ajar agar peserta didik “tahu bagaimana”. Ranah 

pengetahuan menggamit transformasi substansi atau materi ajar agar peserta didik 

“tahu apa.” Hasil akhirnya adalah peningkatan dan keseimbangan antara 

kemampuan untuk menjadi manusia yang baik (soft skills) dan manusia yang 

memiliki kecakapan dan pengetahuan untuk hidup secara layak (hard skills) dari 

peserta didik yang meliputi aspek kompetensi sikap, keterampilan, dan 

pengetahuan.  Kurikulum 2013 menekankan pada dimensi pedagogik modern 

dalam pembelajaran, yaitu menggunakan pendekatan ilmiah.  Pendekatan ilmiah 

(scientific appoach) dalam pembelajaran sebagaimana dimaksud meliputi 

mengamati, menanya, mencoba, mengolah, menyajikan, menyimpulkan, dan 

mencipta untuk semua mata pelajaran (Kemendikbud, 2013: 3). 
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Berdasarkan uraian di atas bahwa pembelajaran dengan pendekatan ilmiah melalui 

tiga ranah yaitu, sikap, pengetahuan dan keterampilan. Ranah sikap mengarah 

pada sikap ingin tahu siswa, ranah pengetahuan mengarah pada ilmu pengatahuan 

yang harus dikuasi, dan ranah keterampilan mengarah siswa tahu cara melakukan 

sesuatu. 

2.6 Bahan Ajar 

 

2.6.1 Definisi Bahan Ajar 

 

Menurut Prastowo (2012: 17) menjelaskan bahwa:  

Bahan ajar merupakan segala bahan (baik informasi, alat, maupun teks) 

yang disusun secara sistematis, yang menampilkan sosok utuh dari 

kompetensi yang akan dikuasai peserta didik dan digunakan dalam proses 

pembelajaran dengan tujuan perencanaan dan penelaahan implementasi 

pembelajaran.  Misalnya, buku pelajaran, LKS, modul, bahan ajar audio, 

bahan ajar  interktif. 

 

Lebih lanjut Belawati dalam Prastowo (2012: 40) menjelaskan bahwa : 

Bahan ajar diklasifikasikan menurut bentuk, cara kerja, dan sifatnya.  

Menurut bentuknya bahan ajar dibedakan menjadi (1) bahan ajar cetak 

seperti buku, modul, dan lembar kerja siswa; (2) bahan ajar audio seperti 

kaset, CD, dan radio; (3) bahan ajar audiovisual seperti VCD dan film; dan 

(4) bahan ajar interaktif seperti CD interaktif.  Sedangkan menurut cara 

kerjanya bahan ajar dibedakan menjadi (1) bahan ajar yang tidak 

diproyeksikan seperti model atau carta; (2) bahan ajar yang diproyeksikan 

seperti slide; (3) bahan ajar audio seperti kaset, CD, dan radio; (4) bahan 

ajar video seperti video dan film; dan (5) bahan ajar komputer seperti 

computer mediated instruction dan computer based multimedia atau 

hypermedia. 

 

Aspek dalam pemilihan bahan ajar perlu memperhatikan berbagai hal yang 

berkaitan dengan isi maupun tampilan sehingga bahan ajar yang diberikan kepada 

siswa dapat menjadikan pembelajaran lebih menarik, inovatif, efektif, dan efisien.  

Pribadi  mengemukakan bahwa pengadaan bahan ajar yang akan digunakan dapat 
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dilakukan melalui beberapa cara, yaitu (1) membeli produk komersial, (2) 

memodifikasi bahan ajar yang telah tersedia, dan (3) memproduksi sendiri bahan 

ajar sesuai tujuan. 

 

Proses pengembangan bahan ajar khususnya banah ajar cetak, perlu diperhatikan 

prinsip-prinsip desain pesan.  Prawiradilaga (2008: 21) menjelaskan bahwa “lima 

komponen yang harus diperhatikan, yaitu (1) kegiatan pembelajaran pendahuluan, 

(2) penyampaian materi pembelajaran, (3) memancing kinerja siswa, (4) 

pemberian umpan balik, dan (5) kegiatan tindak lanjut”.  

 

Secara lebih khusus pada pengembangan bahan ajar cetak, Arsyad (2010: 87) 

menjelaskan “ada enam elemen yang perlu diperhatikan pada saat merancang, 

yaitu (1) konsistensi, (2) format, (3) organisasi, (4) daya tarik,(5) ukuran huruf, 

dan (6) ruang/spasi kosong.  Selain itu, ada komponen lain yang digunakan untuk 

menarik perhatian siswa pada bahan ajar cetak yaitu warna, huruf, dan kotak”. 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa dalam pembuatan bahan 

ajar perlu memperhatikan berbagai aspek yang berkaitan dengan isi dan tampilan 

bahan ajar. Selain itu fleksibilitas (dapat diadaptasikan dengan banyak tujuan), 

portabilitas (mudah dibawa tanpa membutuhkan perlengakapan lain), ramah bagi 

pengguna (tidak membutuhkan keahlian khusus untuk menggunakannya), dan 

ekonomis juga menjadi hal yang harus menjadi perhatian dalam pembuatan bahan 

ajar. Sehingga dengan bahan ajar yang sesuai dengan kebutuhan siswa, maka 

proses pembelajaran dapat berjalan dengan baik. 
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2.6.2. Pengembangan Bahan Ajar Menurut Gagne, Briggs, dan Wager 

   

Gagne, dalam Prawiladilaga (2008:15) mengembangkan konsep dalam desain 

pembelajaran dengan menyatakan bahwa:  

Desain pembelajaran membantu proses belajar seseorang dinama proses 

belajar itu sendiri memiliki tahapan segera dan jangka panjang.  Proses 

belajar terjadi karena adanya kondisi-kondisi belajar internal maupun 

eksternal. Kondisi internal adalah kemampuan dalam kesiapan diri 

pebelajar, sedangkan kondisi eksternal adalah pengaturan lingkungan yang 

didesain.  Penyiapan kondisi eksternal belajar inilah yang disebut sebagai 

desain pembelajaran.  Untuk itu desain pembelajaran harus sistematis, dan 

menerapkan konsep pendekatan system agar hasil belajar meningkatkan 

mutu kinerja seseorang.   

 

 

Pada prinsipnya dalam mendesain pembelajaran memiliiki tahapan jangka pendek 

dan panjang dan harus memperhatikan aspek internal dan eksternal. 

 

Selanjutnya Prawiladilaga (2008:25) menyatakan bahwa teori pembelajaran 

Gagne terkenal dengan sebutan events of instruction yang terdiri atas sembilan 

tahapan yaitu: 

a.  Stimulation to gain attention ensure reception of stimuli 

b. Informing learners of the learning objective, to establish appropriate 

expectations 

c. Reminding learners of previously learned content for retrieval from 

LTM 

d. Clear and distinctive presentation of material to ensure selective 

perception 

e. Guidance of learning by suitable semantic encoding 

f. Eliciting performance, involving response generation 

g. Providing feedback about performance 

h. Assessing the performance, involving additional response feedback 

occasions 

i. Arranging variety practice aid future retrieval and transfer 

 

 

Lebih lanjut Prawiladilaga (2008: 50) menyatakan bahwa model yang diajukan 

oleh ketiga tokoh ini terdiri dari empat tahap yaitu 
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1.    Jenjang sistem 1, yaitu 

a. Analisis kebutuhan, tujuan kurikuler, dan prioritas kurikulum 

b. Analisis sumber-sumber, hambatan, dan alternative system     

      penyampaian 

c. Penentuan cakupan dan urutan dari kurikulum dan mata ajar serta  

     desain system penampilan 

1. Jenjang mata ajar 

j.  Menentukan struktur dan urutan mata ajar 

k. Analisis tujuan umum pembelajaran mata ajar 

 

2. Jenjang KBM 

a. Merumuskan tujuan pembelajaran/kinerja 

b. Mempersiapkan satuan pelajaran 

c. Mengembangkan dan memilih bahan ajar dan media mengukur   

      kinerja peserta 

 

3. Jenjang sistem 2 

a. Menentukan asessmen 

b. Persiapan pengajar 

c. Evaluasi formatif 

d. Uji coba, perbaikan 

e. Evaluasi sumatif 

f. Penggunaan dan penyebaran  

 

Berdasarkan uraian di atas dapat disimpulkan bahwa tahapan pengembanngan 

bahan ajar dimulai dari analisis kebutuhan, persiapan materi, evaluasi, dan 

penggunaan produk. 

 

2.7 Desain Pembelajaran  

 

Desain sistem pembelajaran berisi langkah-langkah yang sistematis dan terarah 

untuk menciptakan proses belajar yang efektif, efisien, dan menarik.  Umumnya 

desain sistem pembelajaran dimulai dari kegiatan analisis yang digunakan untuk 

menggambarkan masalah pembelajaran yang akan dicari solusinya.  Setelah 

masalah pembelajaran diketahui langkah selanjutnya adalah menentukan solusi 

yang akan digunakan untuk mengatasi tersebut.  Hasil dari proses desain sistem 

pembelajaran berisi rancangan sistematik dan menyeluruh dari sebuah aktivitas 
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atau proses pembelajaran yang diaplikasikan untuk mengatasi masalah 

pembelajaran. 

 

Dalam desain pembelajaran dikenal beberapa model yang dikemukakan oleh para 

ahli. Secara umum, model desain pembelajaran dapat diklasifikasikan ke dalam 

model  berorientasi kelas, model  berorientasi sistem, model  berorientasi produk, 

model  prosedural dan model  melingkar.  Salah satu model desain pembelajaran 

yang berorientasi kelas adalah model ASSURE. 

   

 

“Model ASSURE merupakan suatu model pembelajaran atau disebut juga model 

berorientasi kelas.  Model ASSURE ini dicetuskan oleh Heinich, dkk. sejak tahun 

1980-an dan dan dikembangkan oleh Smaldino (Prawiradilaga, 2008: 47)”.   

 

Tahapan langkah-langkah model ASSURE menurut Smaldino (2011: 111) adalah 

sebagai berikut: 

 

1) Analyze Learners (Menganalisis Siswa/Pembelajar) 

Menganalisis kebutuhan belajar siswa adalah langkah awal yang 

dilakukan sebelum kita melaksanakan pembelajaran untuk mengetahui 

kelemahan dan usaha guru yang digunakan sebagai penelitian.  Langkah 

ini merupakan dasar perencanaan proses pembelajaran yang akan 

dilakukan.  

 

2) State Objectives (Menyatakan Tujuan) 

Perumusan tujuan ini berkaitan dengan apa yang ingin dicapai. Hal-hal 

yang perlu diperhatikan dalam perumusannya adalah : 
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a)  Menetapkan ABCD (Audiens, Behavior, conditions, Degree) 

b) Mengklasifikasikan Tujuan 

Menentukan pembelajaran yang akan kita laksanakan lebih 

cenderung ke domain kognitif, afektif, psikomotor, atau 

interpersonal. 

c) Perbedaan Individu  

Berkaitan dengan kemampuan individu dalam menuntaskan atau 

memahami sebuah materi yang diberikan.  

 

3) Select Methods, Media, and Material (Memilih Strategi, Media dan 

Material) 

 

Dalam memilih strategi yang digunakan maka harus yang berpusat pada 

siswa, karena dengan demikian siswa akan mampu mencapai tujuan 

pembelajaran dengan baik dengan bantuan guru. 

 

4) Utilize Media and Materials (Menggunakan Media dan Materi) 

Perencanaan yang dilakukan dalam menggunakan media dan materi 

pembelajaran melalui beberapa proses, yaitu: (1) Preview (pratinjau); 

(2) Mempersiapkan bahan media dan materi; (3) Mempersiapkan 

lingkungan belajar; (4) Mempersiapkan siswa; (5) Provide atau 

menyediakan pengalaman belajar (berpusat pada siswa). 

 

5) Require Learner Participation (Mengharuskan Partisipasi Siswa) 

Dalam mengaktifkan siswa dalam proses pembelajaran sebaiknya 

memperhatikan sisi psikologis siswa seperti  behavioris, kognitifis, 

konstruktivis, dan  sosial.    
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6) Evaluate and Review (Mengevaluasi dan Merevisi) 

Evaluasi dan merevisi dilakukan untuk melihat seberapa jauh 

pembelajaran efektif dalam pencapaian kompetensi yang telah 

direncanakan. Jika kompetensi belum tercapai maka perlu dilakukan 

revisi terhadap perencanaan pembelajaran. 

 

2.8 Kawasan Pengembangan Bahan Ajar Multimedia dalam Kawasan 

Teknologi Pendidikan 

 

 

Kawasan Pengembangan Bahan Ajar Multi Media dalam Kawasan Teknologi 

Pendidikan berada pada kawan desain dan pengembangan.   

 

1.    Kawasan Desain 

 

Kawasan desain adalah proses untuk menentukan kondisi belajar dengan 

tujuan untuk menciptakan strategi dan produk. Kawasan desain meliputi 

empat cakupan utama dari teori dan praktek, yaitu : 

(1) Desain Sistem Pembelajaran; 

(2) Desain Pesan; 

(3) Strategi Pembelajaran; 

(4) Karakteristik Pembelajar.  

 

Pengembangan bahan ajar multimedian termasuk dalam cakupan desain 

sistem pembelajaran.  Desain Sistem Pembelajaran; yaitu prosedur yang 

terorganisasi, meliputi: langkah-langkah :  

(a) penganalisaan (proses perumusan apa yang akan dipelajari);  

(b) perancangan (proses penjabaran bagaimana cara mempelajarinya); 



52 

 

(c) pengembangan (proses penulisan dan pembuatan atau produksi bahan-  

     bahan pelajaran);  

(d) pelaksanaan/aplikasi (pemanfaatan bahan dan strategi)  

(e) penilaian (proses penentuan ketepatan pembelajaran).  

 

Desain sistem pembelajaran biasanya merupakan prosedur linier dan 

interaktif yang menuntut kecermatan dan kemantapan. Agar dapat berfungsi 

sebagai alat untuk saling mengontrol, semua langkah-langkah tersebut harus 

tuntas. Dalam desain sistem pembelajaran, proses sama pentingnya dengan 

produk, sebab kepercayaan atas produk berlandaskan pada proses (Akhmad 

Sudrajat, 2008: 3). 

 

Berdasarkan uraian di atas, desain adalah kawasann yang termasuk dalam 

pengembangan teknologi pendidikan. Secara umum desain pembelajaran 

disusun berdasarkan langkah-langkah yang berfungsi sebagai control 

penyusunan desain pembelajaran 

2. Kawasan Pengembangan 

Pengembangan adalah proses penterjemahan spesifikasi desain ke dalam 

bentuk fisik, di dalamnya meliputi: 

(1) teknologi cetak; 

(2) teknologi audio-visual;  

(3) teknologi berbasis komputer;  

(4) teknologi terpadu.   

http://akhmadsudrajat.wordpress.com/2008/04/20/teknologi-pembelajaran/
http://akhmadsudrajat.wordpress.com/2008/04/20/teknologi-pembelajaran/
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Kawasan pengembangan berakar pada produksi media. Di dalam kawasan 

pengembangan terdapat keterkaitan yang kompleks antara teknologi dan teori 

yang mendorong terhadap desain pesan maupun strategi pembelajarannya. 

Pada dasarnya kawasan pengembangan terjadi karena:  

(1) pesan yang didorong oleh isi;  

(2) strategi pembelajaran yang didorong oleh teori;  

(3) Manifestasi fisik dari teknologi perangkat keras, perangkat lunak, dan   

     bahan pembelajaran (Akhmad Sudrajat, 2008: 4). 

Berdasarkan uraian di atas, bahwa salah satu kawasan pengembangan adalah 

melalui pengembangan teknologi berbasis komputer dalam pembelajaran. Selan 

itu juga dapat dikembangkan melalaui teknologi audiovisual.  

2.9 Program Tutorial 

 

Nana Sudjana dalam Rusman (2011: 69) menyatakan “model tutorial dalam 

pembelajaran berbasis komputer pola dasarnya mengikuti pembelajaran 

berprogram tipe branching di mana konten materi pelajaran disajikan dalam unit-

unit kecil, lalu disusul dengan pertanyaan. Respon siswa dianalisis oleh komputer 

(diperbandingkan dengan jawaban yang diintegrasikan oleh penulis program) dan 

umpan baliknya yang benar diberikan”. 

 

“Penggunaan model tutorial melalui CD interaktif lebih efektif untuk mengajarkan 

penguasaan software kepada siswa dibandingkan dengan mengajarkan hardware” 

(Rusman, 2011: 69). Kelebihan model tutorial ini dapat membimbing siswa secara 

tuntas menguasai materi dengan cepat dan menarik. Selain itu dapat digunakan 

http://akhmadsudrajat.wordpress.com/2008/04/20/teknologi-pembelajaran/
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untuk menunjang belajar mandiri siswa, sehingga siswa dapat kapan saja belajar 

tanpa harus bergantung pada kehadiran guru di kelas. Siswa juga dapat langsung 

mempraktikkan apa yang telah dipelajari karena dalam CD interaktif terdapat 

fungsi repeat yang bermanfaat untuk mengulangi materi secara berulang-ulang 

untuk penguasaan yang lebih menyeluruh. 

 

Program tutorial pada dasarnya sama dengan program yang bertujuan memberikan 

bantuan kepada siswa agar dapat belajar secara optimal. Kegiatan tutorial ini 

memang sangat di siswa yang dibimbing melaksanakan kegiatan belajar mandii 

sumber dari modul-modul dalam bidang studi tertentu. Itu sini sering dikaitkan 

dengan program pembelajaran modular. ajaran ini direalisasikan dalam berbagai 

bentuk, yakni pusat program pembinaan jarak jauh, dan sistem belajar jarak jauh. 

 

Tutorial didefinisikan sebagai bentuk pembelajaran pembimbing yang 

terkualifikasi, penggunaan mikro komputer pembelajaran. Tutorial dengan metode 

alternatif diantaranya demonstrasi, penemuan bacaan atau pengalaman yang 

membutuhkan verbal dan tulisan serta adanya ujian. 

 

Program tutorial merupakan program pembelajaran yang digunakan dalam proses 

pembelajaran dengan menggunakan software berupa program komputer yang 

berisi materi pelajaran dan soal-soal latihan. Perkembangan teknologi komputer 

membawa banyak perubahan pada sebuah program pembelajaran yang seharusnya 

didesain terutama pada upaya menjadikan teknologi ini mampu merekayasa 

keadaan sesungguhnya. Penekanannya terletak pada upaya yang 

berkesinambungan untuk memaksimalkan aktivitas pembelajaran sebagai 
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interaksi kognitif antara siswa, materi pelajaran, dan perangkat komputer yang 

telah diprogram. 

 

Adapun fungsi tutorial, yaitu sebagai berikut:  

(1) Kurikuler, yakni sebagai pelaksana kurikulum sebagaimana telah dibutuhkan 

bagi masing-masing modul dan mengkomunikasikannya kepada siswa 

(2) Pembelajaran, yakni melaksanakan proses pembelajaran agar para siswa aktif 

belajar mandiri melalui program interaktif yang telah dirancang dan 

ditetapkan; (3) diagnosis-bimbingan, yakni membantu para siswa yang 

mengalami kesalahan, kekeliruan, kelambanan, masalah dalam mempelajari 

berbasis komputer berdasarkan hasil penilaian, baik formatif maupun sumatif, 

sehingga siswa mampu membimbing diri sendiri 

(4) Administratif, yakni melaksanakan pencatatan, pelaporan, penilaian, dan 

teknis administratif lainnya sesuai dengan tuntutan program CBI 

(5) Personal, yakni memberikan keteladanan kepada siswa seperti penguasaan 

mengorganisasikan materi, cara belajar, sikap dan perilaku yang secara tak 

langsung menggugah motivasi belajar mandiri dan motif berprestasi yang 

tinggi  

 

Tujuan pembelajaran tutorial, yaitu untuk: 

(1)  Meningkatkan penguasaan pengetahuan para siswa sesuai dengan yang 

dimuat dalam software pembelajaran: melakukan usaha-usaha pengayaan 

materi yang relevan 
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(2)  Meningkatkan kemampuan dan keterampilan siswa tentang cara memecahkan 

masalah, mengatasi kesulitan atau hambatan agar mampu membimbing diri 

sendiri 

(3)  Meningkatkan kemampuan siswa tentang cara belajar mandiri dan  

      menerapkannya pada masing CBI yang sedang dipelajari 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa pembelajaran tutorial 

bertujuan untuk memberikan "kepuasan" pemahaman secara tuntas (mastery lea) 

ning) kepada siswa mengenai pelajaran yang sedang dipelajari. Terdapat beberapa 

hal yang identitas dari tutorial yaitu: pengenalan, penyajian informasi, perespon 

jawaban, penilaian respon, pemberian umpan balik tentang pembetulan, segmen 

pengaturan pembelajaran, dan penutup. 

 

Komputer sebagai tutor berorientasi pada upaya dalam perilaku siswa melalui 

penggunaan komputer. Secara sederhana pengoperasiannya adalah sebagai 

berikut: 

(1) Komputer menyajikan 

(2) Siswa memberikan respon 

(3) Respon siswa dievaluasi oleh dengan orientasi pada arah siswa dalam  

     menempuh prestasi 

(4) Melanjutkan atau mengulangi tahapan sebelumnya 

 

Tutorial dalam program pembelajaran berbasis komputer sebagai pengganti 

sumber belajar yang proses pembelajarannya lewat teks, grafik, animasi, audio 

yang tampak pada monitor yang diakan pengorganisasian materi, soal-soal latihan 

dan pemecahan Jika respon siswa benar, komputer akan terus bergerak pada 
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berikutnya, namun sebaliknya jika respon siswa salah komputer mengulangi 

pembelajaran sebelurnnya atau bergerak pada salah bagian tertentu tergantung 

pada kesalahan yang dibuat. 

 

Tahapan atau langkah-langkah pembelajaran berbasis model tutorial menurut 

Rusman (2013: 211–212) adalah sebagai berikut: 

1) Penyajian informasi (Presentation of information), yaitu berupa 1 

pelajaran yang akan dipelajari siswa 

2) Pertanyaan dan Respon (Question of responses), yaitu berupa latihan 

yang harus dikerjakan siswa 

3) Penilaian respon (Judging of responses), yaitu komputer akan 

respon terhadap kinerja dan jawaban siswa 

4) Pemberian balikan respon (Providing feedback about respo setelah 

selesai, program akan memberikan balikan. Apakah telah berhasil atau 

harus mengulang. 

5) Pengulangan (Remediation) 

6) Segmen pengaturan pelajaran (Sequencing lesson segment) 

 

 

Berdasarkan uraian di atas, dapat disimpulkan bahwa secara umum langkah 

pembelajaran berbasis model tutorial adalah diawali oleh penyajian informasi, 

adanya respon, umpan balik respon, pengulangan, dan pengaturan kembali 

pembelajaran. 

  

2.10   Pengembangan Media Pembelajaran Berbasis Komputer 

 

 

Menurut Sugiyono (2011: 297), metode penelitian dan pengembangan atau 

reasearch and development adalah 

Metode penelitian yang digunakan untuk menghasilkan produk tertentu, dan 

menguji keefektifan produk tersebut. Untuk menghasilkan produk tertentu, 

diperlukan penelitian yang bersifat analisis kebutuhan dan untuk menguji 

keefektifan produk tersebut supaya dapat berfungsi di masyarakat luas, 

maka diperlukan penelitian untuk menguji keefektifan produk tersebut.  
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Berdasarkan uraian di atas bahwa metode penelitian pengembangan pada 

prinsipnya menguji keefektifan produk yang didasarkan pada analisis kebutuhan, 

dan bermanfaat. 

 

2.10.1  Animasi 

 

 

Yudhiantoro (2006: 9) mengemukakan bahwa  “animasi adalah susunan gambar 

diam (static graphics) yang dibuat efek sehingga seolah-olah tampat bergerak”. 

Contoh animasi yang sederhana antara lain, tulisan bergerak atau gambar yang 

dapat bergerak dari menghadap ke kiri dank ke kanan.  

 

Dikaitkan dengan pembelajaran, media animasi dimaknai sebagai alat 

komunikasi yang berupa penayangan frame-frame gambar secara cepat untuk 

menghasilkan kesan gerakan yang digunakan dalam proses pembelajaran untuk 

membawa informasi berupa materi ajar dari pengajar kepada peserta didik 

sehingga peserta didik menjadi lebih tertarik untuk mengikuti kegiatan 

pembelajaran. 

 

Para ahli sepakat bahwa media pendidikan dapat mempertinggi proses belajar 

siswa dalam pembelajaran yang pada gilirannya diharapkan dapat mempertinggi 

hasil belajar yang dicapai. Manfaat media pendidikan dalam proses belajar siswa 

antara lain: 

1. Bahan pembelajaran akan lebih jelas maknanya sehingga dapat lebih 

dipahami oleh para siswa, dan memungkinkan siswa menguasai tujuan 

pembelajaran lebih baik. 
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2. Metode mengajar akan lebih bervariasi, tidak semata-mata komunikasi 

verbal melalui penuturan kata-kata oleh guru, sehingga siswa tidak bosan 

dan guru tidak kehabisan tenaga, apalagi bila guru mengajar untuk setiap 

jam pelajaran. 

3. Siswa lebih banyak melakukan kegiatan belajar, sebab tidak hanya 

mendengarkan uraian guru, tetapi juga aktivitas lain seperti mengamati, 

melakukan, mendemonstrasikan, dan lain-lain. 

4. Pembelajaran akan lebih menarik perhatian siswa sehingga dapat 

menumbuhkan motivasi belajar. 

  

Penggunaan media pendidikan dapat mempertinggi proses dan hasil belajar. 

Taraf berpikir manusia mengikuti tahap perkembangan dimulai dari berpikir 

konkrit menuju ke berpikir abstrak, dimulai dari berpikir sederhana menuju ke 

berpikir kompleks. Penggunaan media pendidikan erat kaitannya dengan 

tahapan berpikir tersebut sebab melalui media pendidikan hal-hal yang abstrak 

dapat dikonkritkan, dan hal-hal yang kompleks dapat disederhanakan. 

 

Ada banyak media yang bisa membantu dalam proses pembelajaran. Software-

software presentasi juga sudah familiar, di masyarakat. Namun pada 

kenyataannya sekarang software presentasi baru sanggup menampilkan materi 

pelajaran yang statis (video, gambar, ataupun tulisan) yang belum dapat 

mensimulasikan proses-proses tertentu. Salah satu yang bisa dijadikan alternatif 

adalah menggunakan visualisasi materi pelajaran dalam bentuk animasi. 
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2.10.2 Media Interaktif 

 

Menurut Susilana dan Riyana (2008 : 22), “mulitimedia interaktif merupakan 

suatu sistem penyampaian dengan menggunakan berbagai jenis bahan belajar 

yang membentuk suatu unit atau paket, dalam pembelajaran dengan multimedia 

interaktif, siswa tidak hanya memperhatikan media atau obyek saja, melainkan 

dituntut untuk berinterkasi selama proses pembelajaran”.  

 

Sementara itu menurut  Miarso (2004 : 464) “multimedia adalah berbagai bahan 

belajar yang membentuk satu unit yang terpadu, dan dikombinasikan atau 

"dipaketkan" dalam bentuk modul dan disebut "kit", yang digunakan untuk belajar 

mandiri atau berkelompok tanpa harus didampingi oleh guru. 

 

Selanjutnya  menurut Heinich (2005 : 141): “The generic multimedia refers to any 

combination of two or more media formats that intergrated to form an 

informational or instructional program. Multimedia systems may consist of 

traditional media in combination or they may incorporate the computer as a 

display divice for text, pictures, graphic, sound and video”. 

 

Berdasarkan ketiga definisi tersebut dapat disimpulkan bahwa multimedia adalah 

gabungan dari dua media atau lebih yang terdiri dari teks, grafis, gambar, foto, 

audio dan video dalam satu kesatuan yang dapat dipergunakan siswa untuk belajar 

baik secara mandiri maupun berkelompok. 
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2.11  Prinsip Belajar Mandiri 

 

Ada beberapa istilah yang mengacu pada pengertian yang sama tentang belajar 

mandiri.  Menurut Candy dalam Chaeruman (2007:49), “istilah-istilah tentang 

belajar mandiri adalah 1) independent learning, 2) self-directed learning, dan 3) 

autonomous learning”. 

 

Sedangkan Knowles dalam Chaeruman (2007: 49) menggambarkan bahwa:  

 

Belajar mandiri sebagai suatu proses dimana individu mengambil 

inisiatif dengan atau tanpa bantuan orang lain untu 1) mendiagnosa 

kebutuhan belajarnya sendiri; 2) merumuskan/menentukan tujuan 

belajarnya sendiri; 3) mengidentifikasi sumber-sumber belajar; 4) 

memilih dan melaksanakan strategi belajarnya; dan 5) mengevaluasi 

hasil belajarnya. 

 

 

Pendidikan dengan sistem belajar mandiri menurut Institut for Distance 

Education of Maryland University seperti dikutip oleh Chaeruman (2007 : 49) 

merupakan srategi pembelajaran yang memiliki karakteristik tertentu yaitu: 

1) Membebaskan pebelajar untuk tidak harus berada pada satu tempat 

dalam satu waktu. 

2) Disediakan berbagai bahan (material) termasuk panduan belajar dan 

silabus rinci serta akses ke semua penyelenggara pendidikan yang 

member layanan bimbingan, menjawab pertanyaan-pertanyaan yang 

diajukan pebelajar, dan mengevaluasi karya-karya pebelajar. 

3) Komunikasi antara pebelajar dengan instruktur atau tutor dicapai 

melalui satu kombinasi dari beberapa teknologi komunikasi seperti 

telepon, voice-mail, konferensi melalui komputer, surat-elektronik 

dan surat menyurat secara regular. r 

 

 

Mengacu dari berbagai pernyataan para ahli tersebut di atas, ada beberapa unsur 

dari konsep belajar mandiri, yaitu: 

1) Kebutuhan belajar adalah tanggung jawab pebelajar itu sendiri. 
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2) Pebelajar memegang kendali dalam pengambilan keputusan untuk mencapai 

kebutuhan belajarnya tersebut. 

3) Dalam upaya mencapai kebutuhan belajarnya tersebut, mereka secara 

individu atau kelompok dapat meminta bantuan kepada orang-orang lain 

yang relevan, seperti guru/tutor, teman dan lain-lain.  

 

Penyelenggaraan sistem belajar mandiri dilakukan dengan pertimbangan secara 

ontologi, epistemilogi, dan aksioilogi. Pertimbangan ontologi yaitu ; manusia 

lahir dalam keadaan berbeda; manusia mempunyai kemampuan untuk belajar 

dan mengembangkan diri sesuai potensi yang ada padanya; dan manusia 

mempunyai kemampuan untuk mengubah dan membentuk kepribadiannya. 

Pertimbangan epistemologi yaitu; memadukan berbagai macam pendekatan dari 

bidang psikologi, komunikasi, manajemen, dan rekasaya; memecahkan masalah 

menyeluruh dan bersistem; mengkaji semua kondisi dan menggunakan teknologi 

sebagai proses dan produk untuk memecahkan masalah; adanya efek sinergi.  

Sedangkan pertimbangan aksiologi yaitu; dapat mempercepat usaha 

peningkatkan mutu kawasaan; tidak diperlukan biaya yang besar; tidak 

terganggunya kegiatan organisasi; meningkatkan mutu pelayanan (Miarso 

2004: 250). 

 

Selanjutnya menurut Miarso (2004: 251), “paling sedikit ada dua hal untuk 

dapat melaksanakan belajar mandiri yaitu:  

1) digunakannya program belajar yang mengandung petunjuk untuk belajar  

    sendiri oleh peserta didik dengan bantuan guru yang minimal,  

2) melibatkan siswa dalam perencanaan dan pelaksanaan kegiatan”. 
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Berdasarkan beberapa uraian di atas, maka peneliti menyimpulkan bahwa belajar 

mandiri merupakan belajar terprogram atau terencana secara matang. Belajar 

mandiri pada prinsipnya adalah berdasarkan kebutuhan si pebelajar yang harus 

terpenuhi dengan motivasi intrinsik yang tinggi pada diri siswa dan minimalisasi 

keterlibatan guru dalam pelaksanaan pembelajaran. Salah satu bantuan untuk 

bahan ajar mandiri adalah program pembelajaran yang dibuat atau dikembangkan 

media komputer yang memungkinkan siswa melakukan kegiatan pembelajaran. 

Walaupun belajar mandiri bersifat individual namun pada pelaksanaannya dapat 

saja terjadi social learning yaitu berkolaborasi dengan siswa lainnya untuk 

mendiskusikan masalah yang terdapat pada program. 

 

2.12 Kriteria Pembelajaran 

 

 

(1)  Efektivitas Pembelajaran  

Pengukuran keefektifan pembelajaran harus selalu dikaitkan dengan pencapaian 

tujuan pembelajaran. Indikator penting yang dapat dipakai untuk menetapkan 

keefektifan pembelajaran yaitu kecermatan penguasaan perilaku, kecepatan unjuk 

kerja, kesesuaian dengan prosedur, kuantitas unjuk kerja, kualitas hasil akhir, 

tingkat alih belajar, dan tingkat retensi.   

a.  Kecermatan penguasaan perilaku juga sering disebut dengan tingkat 

kesalahan unjuk kerja, dapat dipakai sebagai indikator untuk 

menetapkan keefektifan pembelajaran. Makin cermat siswa menguasai 

perilaku yang dipelajari, makin efektif pembelajaran yang telah 

dijalankan. Atau, dengan ungkapan lain, makin kecil tingkat kesalahan, 

berarti makin efektif pembelajaran 
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b. Kecepatan dalam unjuk kerja dikaitkan dengan jumlah waktu yang 

diperlukan dalam menampilkan unjuk kerja itu. Makin cepat seorang 

siswa manampilkan unjuk kerja, semakin efektif pembelajaran 

c. Kesesuaian unjuk kerja dengan prosedur baku yang telah ditetapkan 

juga dapat dijadikan indikator keefektifan pembelajaran. Pembelajaran 

dikatakan efektif apabila pembelajar dapat menampilkan unjuk kerja 

yang sesuai dengan prosedur baku yang telah ditetapkan. Indikator ini 

penting sekali khususnya untuk unjuk kerja tipe isi prosedural, baik tipe 

isi prosedural yang menunjukkan hubungan prasyarat, maupun tipe isi 

prosedural yang menunjukkan hubungan putusan 

d. Kuantitas unjuk kerja mengacu kepada banyaknya unjuk-kerja yang 

mampu ditampilkan oleh siswa dalam waktu tertentu yang telah 

ditetapkan. Perancang pembelajaran  banyak yang mengaitkan kuantitas 

unjuk kerja ini pada jumlah tujuan yang dicapai siswa. Makin banyak 

tujuan yang tercapai berarti makin efektif pembelajaran. Dengan 

ungkapan lain, keefektifan suatu pembelajaran dapat diukur dengan 

banyaknya unjuk-kerja yang mampu diperlihatkan oleh siswa 

e. Mengamati kualitas hasil unjuk kerja. Umpamanya, unjuk kerja melukis. 

yang diamati bukan unjuk kerja ketika siswa melukis, tetapi lukisannya 

setelah selesai digarap  

f. Tingkat alih belajar, kemampuan siswa dalam melakukan alih belajar 

dari apa yang telah dikuasainya ke hal lain yang serupa, juga 

merupakan indikator penting untuk menetapkan keefektifan 

pembelajaran. Indikator ini banyak terkait dengan indikator-indikator 
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sebelumnya, seperti: tingkat kecermatan, kesesuaian prosedur, dan 

kualitas hasil akhir. Oleh karena itu, penetapan keefektifan 

pembelajaran berdasarkan tingkat alih belajar, perlu didasarkan pada 

informasi mengenai indikator-indikator tersebut 

g. Tingkat retensi, yaitu jumlah unjuk-kerja yang masih mampu 

ditampilkan siswa setelah selang periode waktu tertentu. Atau, dengan 

menggunakan konsepsi memory theorists, jumlah informasi yang masih 

mampu diingat atau diungkapkan kembali oleh pembelajar setelah 

selang waktu tetentu. Jadi, makin tinggi retensi berarti semakin efektif 

pembelajaran itu. Sebagai indikator dari pengukuran keefektifan 

pembelajaran, tingkat retensi lebih tepat dipakai pada pembelajaran  

yang menekankan ingatan 

 

(2)  Efisiensi pembelajaran 

Efisiensi dalam  proses pembelajaran dapat dilihat dari beberapa indikator yaitu 

a. waktu  

1) membandingkan pelaksanaan beberapa program yang berbeda 

dalam jumlah waktu yang sama 

2) Rasio jumlah tujuan yang dicapai siswa debandingkan dengan 

jumlah waktu yang digunakan untuk mencapai tujuan  

3) Indeks efisiensi dapat dihitung masing-masing siswa dan rata–rata 

keseluruhan indeks untuk mencerminkan efisiensi program 

pembelajaran, Semakin tinggi indeks, semakin tinggi efisiensi 

belajar 
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 b. Personalia  

1) Jumlah personalia yg dilibatkan dalam perancangan, pelaksanaan 

dan penilaian pembelajaran),  

2) Rasio guru dan siswa 

             c. Sumber belajar  

1) membandingkan jumlah siswa yang memanfaatkan sumber belajar 

dalam kurun waktu tertentu. Makin banyak siswa yg menggunakan 

media dalam waktu yang singkat, semakin efektif media tersebut. 

2) Biaya untuk menyampaikan materi lebih efisien daripada  

           menggandakan sejumlah siswa. 

 

(3)  Kemenarikan 

Daya tarik pembelajaran diukur dengan mengamati kecenderungan siswa untuk 

tetap atau terus belajar. Daya tarik pembelajaran dilihat dari beberapa indikator  

yaitu strategi pengorganisasian, strategi penyampaian, dan strategi pengelolaan 

pembelajaran.   

1. Strategi pegorganisasian adalah cara untuk membuat urutan 

(Sequencing) dan mensintesis (synthesizing) fakta, konsep, prosudur, 

dan prinsip yang berkaitan dengan  suatu isi pembelajaran.  Strategi 

pengorganisasian mencakup strategi pengorganisasian makro (menata 

urutan keseluruhan isi bidang studi), dan mikro (menata urutan sajian 

konsep, prinsip atau prosedur). 

2. Strategi penyampaian adalah cara untuk menyampaikan pembelajaran 

pada siswa dan atau untuk menerima serta merspons masukan dari 
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siswa.  Strategi penyampaian mencakup media pembelajaran, interaksi 

belajar dan bentuk pembelajaran. 

3. Strategi pengolahan adalah cara untuk menata intraksi antara siswa 

dan variabel pembelajaran (varaiabel strategi pengorganisasian dan 

penyampaian). Strategi pengolahan pembelajaran berhubungan. 

dengan.pemilihan.tentang.strategi.pegorganisasian.  Strategi juga ini 

mencakup  penjadwalan, pembuatan catatan, motivasi, dan kontrol 

belajar.  

(whenlinge.blongspot.com/2012/01/strategi pembelajaran.html) 

 

2.13  Penelitian yang Relevan 

 

 

Beberapa penelitian sejenis yang relevan dengan penelitian dan pengembangan 

yang dilakukan oleh peneliti, antara lain: 

1. Dalam MERLOT Journal of Online Learning and Teaching Vol. 6, No. 2, 

June 2010; Barbara A. Frey dan Jann Marie Sutton menulis jurnal berjudul “A 

Model for Developing Multimedia Learning Projects”, Tujuan dari  jurnal ini 

adalah untuk menyajikan panduan ringkas pengembangan multimedia 

berdasarkan penelaahan literatur dan teknik Delphi dengan pendidik ahli, 

desainer, dan pemrogram. Setelah review dua putaran dan umpan balik dari 

penguji ahli, langkah berikutnya model pengembangan multimedia akan 

terdiri dari: (1) menentukan tujuan instruksional, tujuan, dan penonton, (2) 

mengkaji dan menyelidiki pilihan yang ada, (3) menentukan format, 

anggaran, dan timeline, (4) menentukan konten, kegiatan, dan strategi 

penilaian, (5) mengembangkan strategi evaluasi, kriteria, dan instrumen untuk 
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menentukan efektivitas proyek, (6) mengembangkan flowchart, peta situs, 

dan atau storyboard, (7) mengembangkan prototipe, (8) melakukan evaluasi 

formatif, (9) menyelesaikan desain, dan (10) melakukan evaluasi sumatif 

produk dan proses. Langkah-langkah ini ditunjukkan melalui pengembangan 

proyek multimedia tertentu. 

2. Dalam Jurnal Speed – Edisi Web 12 – Februari 2012; Wawan Saputra, 

Bambang Eka Purnama, dan Endang Puji Rahayu menulis jurnal berjudul 

“Pengembangan Multimedia Pembelajaran Interaktif Untuk Mata Kuliah 

Organisasi Komputer”, pada jurnal ini menyimpulkan bahwa pemanfaatan 

teknologi komputer di bidang pembelajaran berupa CD interaktif 

dikembangkan atas dasar asumsi bahwa proses komunikasi di dalam 

pembelajaran akan lebih menarik minat mahasiswa dan memberikan 

kemudahan untuk memahami materi karena penyajiannya yang interaktif, 

dengan memanfaatkan berbagai media sebagai sarana penunjang kegiatan 

pembelajaran. Media interaktif dapat di artikan sebagai kombinasi berbagai 

unsur media yang terdiri dari teks, grafis, foto, animasi, video, dan suara yang 

disajikan secara interaktif dalam media pembelajaran. 

3. Dalam jurnal penelitian pendidikan IPA; Widhiyanti, Liliasari, dan Budi 

(2007), melakukan penelitian dan pengembangan dengan judul 

Pembelajaran Berbasis Teknologi Informasi  Untuk Meningkatkan 

Pemahaman Konsep dan Keterampilan Berpikir kritis Siswa pada Topik 

Sifat Koligatif Larutan. Penelitian yang dilakukan  dengan menggunakan 

desain penelitian jenis pre test-post test one group design. Kesimpulan 

dalam penelitian ini adalah Pembelajaran Berbasis Teknologi Informasi 
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pada Topik Sifat Koligatif Larutan dapat meningkatkan pemhaman konsep 

siswa pada nilai N-Gain kategori sedang. Pembelajaran ini juga dapat 

meningkatkan keterampilan berpikir kritis siswa pada nilai N-Gain kategori 

sedang. 

4. Dalam jurnal penelitian pendidikan IPA; Putra S,  Hendayana, dan  Muzakir 

(2007) melakukan penelitian dan pengembangan dengan judul Model 

Pembelajaran Redoks Berbasis Komputer Untuk Meningkatkan Pemahaman 

Konsep dan Keterampilan Berpikir kritis Siswa SMK. Metode yang 

digunakan dalam penelitian ini adalah metode quasi eksperimen dengan pre 

test-post test one group design. Kesimpulan dalam penelitian ini adalah: 

model pembelajaran yang dikembangkan dapat meningkatkan pemahaman 

konsep dan keterampilan berpikir kritis siswa dan dapat diterapkan pada 

kelompok siswa yang berkemampuan tinggi, sedang, dan rendah.  Model 

pembelajaran yang dikembangkan mendapat tanggapan positif dari siswa 

dan guru. 

5. Dalam jurnal penelitian pendidikan IPA; Junaedi (2007) melakukan 

penelitian dengan judul Implementation of Cooperative Learning Type 

Group Investigation in Heat Materials for Improving Student Science of 

GenericSkills.  Metode yag digunakan adalah metode eksperimen semu 

yang melibatkan dua kelas dengan perlakuan yang berbeda.  Kelas pertama 

diberikan perlakuan pembelajaran kooperatif group investigation 

menggunakan selft assessmet yang selanjutnya disebut kelas eksperimen 

dan kelas kedua diberi perlakuan pembelajaran konvensional sebagai kelas 

control. Desain penelitian yang digunakan adalah pretest-posttest equivalent 
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groups design. Kesimpulan dalam penelitian ini adalah pembelajaran 

kooperatif group investigation menggunakan selft assessmet dapat 

meningkatkan keterampilan generic sains siswa sampai pada kategori 

sedang dan secara signifikan lebih baik daripada pembelajaran 

konvensional. 

 

2.14.  Kerangka Berpikir 

 

Suatu bahan ajar dikatakan efektif apabila dapat membantu siswa 

mengembangkan pemahaman terhadap materi pelajaran yang sedang diajarkan 

oleh guru. Dengan bahan ajar yang digunakan siswa menjadi terbantu 

mempelajari suatu materi pelajaran dengan baik yang pada akhirnya dapat 

meningkatkan hasil belajar siswa. Ciri-ciri penerapan bahan ajar pembelajaran 

yang efektif terlihat dari adanya perubahan sikap pada siswa, yaitu meningkatnya 

rasa ingin tahu siswa, aktivitas belajar, tertarik dengan materi, dan senang 

mengikuti pelajaran. 

 

Banyak upaya yang telah dilakukan oleh guru untuk meningkatkan efektivitas 

pembelajaran, salah satunya penggunaan media pembelajaran. Namun pada 

kenyataaannya tidak semua media yang digunakan dapat meningkatkan 

pemahaman siswa yang signifikan terhadap materi yang pembelajaran yang 

disampaikan.  Hal ini disebabkan media yang digunakan secara umum adalah 

media gambar tidak bergerak, sehingga tidak menarik bagi siswa.  Pada umumnya 

penggunaan media yang efektif terlihat dari kemenarikan media itu sendiri.   
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Penggunaan bahan ajar pembelajaran memiliki peran yang sangat penting 

dalam meningkatkan daya tarik siswa dalam belajar, sehingga dapat 

meningkatkan minat dan motivasi belajar.  Selain itu, proses pembelajaran 

lebih bervariatif, tidak hanya komunikasi verbal oleh guru, tetapi juga 

pengamatan langsung oleh siwa, sehingga mereka tidak bosan belajar. Selain 

itu, penggunaan bahan ajar juga meningkatkan aktivitas belajar siswa. Siswa 

tidak hanya mendengarkan penyampaian materi oleh guru, tetapi juga aktif 

mengamati langsung, melakukan, dan mendemonstrasikan. Selanjutnya bahwa 

penggunaan bahan ajar didasarkan pada tingkat kebutuhan siswa melalui 

proses tanya jawab, evaluasi ahli, dan ujicoba.   

 

Konsep pembelajaran di atas sejalan dengan pembelajaran dengan menggunakan 

pendekatan ilmiah.  Pendekatan ilmiah (scientific appoach) dalam pembelajaran 

sebagaimana dimaksud meliputi mengamati, menanya, mencoba, mengolah, 

menyajikan, menyimpulkan, dan mencipta untuk semua mata pelajaran.  Hal ini 

berarti ada kreativitas guru dalam menyusun bahan ajar, sehingga dapat mencapai 

hasil belajar yang optimal. Proses pendekatan ilmiah ini sangat mungkin 

diterapkan dengan memanfaatkan teknologi komputer. 

 

Seiring dengan perkembangan teknologi komputer, telah banyak diciptakan 

program (software) komputer yang dapat digunakan sebagai media pembelajaran.  

Program-program yang diciptakan dapat memenuhi seluruh syarat untuk dijadikan 

bahan ajar yang efektif, yaitu media interaktif. Salah satunya adalah 

pengembangan bahan ajar tutorial berbasis komputer software adobe audition.  

Program ini termasuk  program multimedia yang bersifat interaktif.  Materi 
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pembelajaran dapat dibuat lebih menarik dan dapat divisualiasikan melalui 

gambar animasi.  Hal ini sudah tentu menyebabkan siswa tertarik terhadap materi 

yang disampaikan oleh guru.  Selanjutnya juga dapat meningkatkan motivasi dan 

aktivitas belajar.   

 

Selain itu, program (software) komputer yang digunakan sebagai bahan ajar dapat 

digunakan secara mandiri oleh siswa. Hal ini sangat mendukung konsep 

pendekatan ilmiah yaitu siswa dapat mencoba program pembelajaran yang 

diciptakan.  Hal ini sudah tentu akan semakin mempermudah siswa untuk 

mempelajari materi pembelajaran.  Siswa lebih memiliki waktu yang relatif 

banyak untuk belajar tentang materi tidak hanya di sekolah tetapi juga dirumah 

atau ditempat lain.   

 

Berdasarkan uraian di atas, maka pengembangan bahan ajar multimedia tutorial 

berbasis komputer lebih efektif untuk meningkatkan hasil belajar siswa 

dibandingkan dengan metode pembelajaran lainnya. 

 

2.15. Hipotesis 

 

Berdasarkan kerangka pikir, hipotesis yang diajukan pada penelitian ini adalah 

hasil belajar siswa sesudah  menggunakan bahan ajar multimedia tutorial 

interaktif lebih baik daripada sebelum menggunakan bahan ajar multimedia 

tutorial interaktif. 

 


